
MacAstro 1.3 is a program for astronomy lovers. It calculates the appearance of 

the sky at any time between the years 1900 and 2100, and from any point on 

earth. It displays the position of the 8 major planets, the Sun, the Moon, and 

the 1000 brightest astronomical objects (stars, nebula, and galaxies). The 

precision of the ephemeris allows one to point to any instrument with an error 

of less than one minute of arc.

Seven files compose the package :

• “MacAstro 1.3,” the main program

• “OptionsMacAstro,” a preference file to drop into the System Folder, with a 

list of the coordinates of 19 major cities in the world, 

• “Star Compiler 1.0,” a program which compiles any text-file catalog of stars 

into a format readable by MacAstro.

• “Stars.1000.CAT,” a text-file with a list of the coordinates of the 1000 

brightest stars and an abbreviated name of constellations (already compiled into 

MacAstro).

• “Stars.250.CAT,” a text-file with a list of the coordinates of the 250 

brightest stars and a full name of constellations.

• “Doc MacAstro 1.3 (MW),” this documentation.

• “READ ME (MacAstro),” a short description of MacAstro.

1. NOTES ABOUT MacAstro

Don't you think it's a pity when, as an astronomy lover, you have to find the 

ephemeris in a book instead of using the computer on your desk ? With the 

exceptional graphical and interactive possibilities of the Macintosh, it is 

possible to display much more information than with a simple “Ephemeris Book.” 

Would you like to see the exact sky under which you were born ? It's possible. 

Would you like to have the current sky permanently updated on background under 

MultiFinder ? It's possible. Your loved one is in Sydney, do you want to see the 

same sky as she or he ? It's possible.

MacAstro is a shareware. Creating this program took me countless hours and a 

great deal of effort, so if you want to keep it, please send me $20.00 (or 

120.00 French francs). It's less than the price of an ephemeris book, which is 

valid for only one year, whereas you will use MacAstro for more than 100 years 

(it's valid until the December, 31 2099…) 

You may evaluate MacAstro for 15 days. If you decide to keep it, please send the 

register form at the end of this document with a $20.00 (or 120.00 French 

francs) check or money order to:

        Nicolas Mercouroff



        P.O.Box # 390929

        Cambridge, MA 02139

        USA

Please indicate your address or email-address, such as I can send you your 

registration number. Any comments or suggestions can be directed to the above 

address or the following email address :

        nm@cs.brandeis.edu

Disclaimer: This program has no relation to Brandeis University.

You are allowed (and encouraged) to distribute MacAstro to anyone you wish 

(including on-line services) provided that it is distributed with its unmodified 

documents, and that you don't ask for monetary compensation, except for possible 

distribution costs.

If you don't want to send the contribution, please destroy all the copies of 

MacAstro you have after 15 days of use.

A special thanks to Jan Stransky for explaining to me what a Macintosh is made 

of (Uh ?), and to Robert Boonstra for helping me fix an ugly bug in the MBDF 

defproc of system 6.0. (Thanx Bob !).

2. USE OF MacAstro

2.1 LAUNCH OF MacAstro

When launched, a dialog “About MacAstro” is displayed if the program is not yet 

registered. If you have paid the shareware fee, select the button “Registered…” 

and enter your registration number (the dialog will not be displayed anymore 

when launching). If you have not yet paid your contribution, select the button 

“Not yet registered.”

Then a dialog “Time & Place” will appear (see 3.2.4 “Time & Place” dialog) 

• if the file “OptionsMacAstro” is not present in the System Folder; or 

• if the option “Time & Date dialog at start up” has been previously selected in 

the “Preferences” dialog (see 3.2.3); or 

• IF THE OPTION KEY IS DEPRESSED. 

You may then select the observation point (i.e. the place from where you will 

observe the sky) and the date and hour of this observation. The place selected 

by default is the previous one (selected during the last use of the program), 

and the time by default is the current one (according to the clock of the 

Macintosh).

Then MacAstro loads the catalog of stars into the memory (1000 stars). If the 

memory is too small to load the catalog, a dialog appears and no catalog of 

stars will be used during the session.



Then a window “Sky of [Name of the place selected]” is displayed. In this window 

all the visible objects will be drawn as they are calculated. If the option 

“Celestial equator” has been selected in the “Preferences” dialog (see 3.2.3), 

the celestial equator, the vernal equinox point and the celestial pole are 

drawn.

2.2 ZOOMING

When the cursor is within the circle delimiting the sky, it looks like a lens 

(fig. below). If the button of the mouse is depressed, a zoom effect enlarges 

the zone clicked by a factor chosen in the “Preferences” dialog (see 3.2.3). The 

pointer now looks like a pointing finger. It is possible to move the zone 

enlarged by clicking and dragging inside the window. Double-click, or select the 

“Zoom Out” option in the “Edit” menu to zoom out.

2.3 BACKGROUND CALCULATION

The calculations are performed in background, which means that THE MACINTOSH IS 

NOT BUSY DURING THE CALCULATIONS. When the coordinates of all objects are not 

yet all determined, the computation starts AFTER 2 seconds of inactivity (like 

in Microsoft Excel® for example). The cursor shows a rotating Moon during the 

computation. The computation stops each time an event arises, or the mouse is 

moved. If the “Compute when ordered” option is selected (in the “Preferences” 

dialog, see 3.2.3), the calculation is performed only when the “Calculate Now” 

item of the “Objects” menu is selected (see 3.5.1.2).



3. DESCRIPTION BY MENUS

3.1 “Apple” MENU

The menu Apple consists of an item “About MacAstro…,” and the Desk Accessories. 

When the item “About MacAstro…” is selected, a dialog with information about 

MacAstro is displayed. The number of objects (8 planets + Sun + Moon + number of 

stars from the catalog) is shown, and the number computed so far.

3.2 “File” MENU

The menu File consists of items for saving as a text file the ephemeris, closing 

the front most window, setting the preferences, setting the date and place of 

observation, launching an animation (planetarium), and quitting the program 

MacAstro.

3.2.1 “Save Ephemeris…” ITEM

The item “Save Ephemeris…” allows to save as a text file the ephemeris of the 8 

major planets, the Sun and the Moon.

A standard “Put File” dialog is displayed (fig. below); it allows to choose the 

name of the text file created, its location, and its “creator.” 

3.2.1.1 “CREATOR” OF THE FILE

When the signature of the favorite text editor is chosen as creator, it is 

possible within the Finder to double-click on the icon of the TEXT file to open 

directly this text editor. It is of course possible anyway to open the text 

directly from any text editor. To choose a “Creator,” click on the pop-up menu 

and either choose one of the signature displayed (for TeachText, MacWrite, 

MSWord or Qued/M), or enter a new one with the “Other…” item.



3.2.1.2 CONTENT OF THE EPHEMERIS TEXT

The ephemeris are saved into a text file, which content is the following: The 

first line of the file is the date, time, and current time difference for the 

observation. The second line is the place chosen with its coordinates. The third 

line is the sidereal time, and the 12 next lines are the ephemeris for the Sun, 

the Moon, Mercury, Venus, Mars, Jupiter, Saturn, Uranus, Neptune and Pluto. For 

each of these objects is indicated : its name, its right-ascension and 

declination, its azimuth and altitude for the time and place chosen, and its 

culmination, rising and setting time for the chosen date. If the time 

corresponds to the eve, it starts with a “-”, if it is for the day after, it 

starts with a “+”. When the object does not rise neither set, the symbol “-- -- 

--” replaces the time.

3.2.2 “Close” ITEM

The “Close” item of the File menu allows to close the front most desk accessory 

or window if it is not the window “Sky of…” (the main window).

3.2.3 “Preferences…” ITEM

The “Preferences…” article allows to set the parameters of MacAstro. When 

selected, a dialog is displayed (fig. below).

3.2.3.1 DISPLAYING OPTIONS

These options allow to choose the way the sky is displayed in the “Sky of…” 

window :

• When “objects Symbols” is checked, the symbols of the 10 objects of the solar 

system are displayed.

• When “Celestial equator” is checked, the celestial equator, the vernal equinox 



point and the celestial pole are drawn.

• When “Display stars” is checked, the stars are displayed in the window “Sky 

of…”

• When “Name stars” is checked, the name of the star is written next to its 

point when a part of the sky is zoomed.

• When “White color” is selected, the sky is displayed in black on a white 

background; when “Black color” is selected, the sky is white on a black 

background.

• The “Zoom coefficient” pop-up menu allows to choose the enlarging factor when 

a part of the sky is zoomed. It can vary from 2 to 64.

• The “Object diameter” pop-up menu allows to choose the diameter of the point 

figuring each object in the sky : 1 point, 2 points, 3 points or variable. When 

“Var.” is selected, the diameter of the point depends on the magnitude of the 

object : from 1 point for the darkest to 3 points for the brightest.

3.2.3.2 GENERAL OPTIONS

• When “Calculation when Ordered” is selected, the computation is performed only 

when the “Calculate now” item from the “Objects” menu is selected. Otherwise, it 

starts when no action takes place for 2 seconds. 

• When “bip at the End” is selected, the Macintosh beeps when all the 

calculations are performed.

• When “Time & Place dialog at start up” is selected, the “Time & Place” dialog 

(see 3.2.4) is displayed each time the program is launched.

3.2.4 “Time & Place…” ITEM

The “Time & Place…” item, when selected, displays a dialog (fig. below) allowing 

to choose the time of the observation, and the place from where this observation 

is made.



3.2.4.1 PLACE

If the file “OptionsMacAstro” is in the system folder, a list of places is 

displayed. It is possible to select any place in this list, to add a new place, 

or to delete a place. The maximum number of places is 20. If the file is not 

present, only New-York is shown.

As the original list in “OptionsMacAstro” consists of 19 places, it is possible 

to delete some places in the original list to make room for other frequently 

used places not in the list.

To select a place, just select it in the list. To delete a place, select it and 

press “Remove” button (the first place — New-York — cannot be deleted). To add a 

place (if the number of places already selected is less than 20), press the 

“New…” button. A new dialog appears (fig. below). Enter the name of the new 

place, its latitude, longitude and usual time difference from GMT (Greenwich 

Meridian Time).

3.2.4.2 TIME

It is possible to choose the date and time of observation (any legal date 

between the first of January 1900, and the 31st of December 2099). It is also 

possible to specify the daylight saving (difference between GMT and the current 

time), which could be different from the usual one (recorded for the place), due 

to seasonal differences (daylight saving).

A button “curr. Time” sets the date & time to the current one stored into the 

Macintosh.

3.2.5 “Animation…” ITEM

The “Animation…” item allows to animate the sky like a planetarium. It is 



possible to choose the acceleration of the time, or a fixed increment or 

decrement for each step. This animation can be performed in background under 

MultiFinder (with another program currently in the foreground).

3.2.5.1 CHOOSE THE STEP OF THE TIME

The “Animation…” item, when selected, displays a dialog (fig. below).

When “real Time” is selected, a pop-up menu allows to select the acceleration of 

the time (between 1 and 32). An acceleration of 1 (no acceleration) means that 

each time the sky is completely computed, a new computation is performed, with 

the time increased by the delay needed for the computation. An acceleration of N 

means that the calculation-time is multiplied by N and the computation is 

performed for the new time increased by this amount.

EXAMPLE : If the computation is launched for 12:00:00, with the acceleration of 

time set to 8, and the execution time is 12 seconds, then the next iteration 

will be computed for 12:00:00 + 8 x 12 = 12:01:36.

When “Increment” or “Decrement” is selected, a fixed increment or decrement is 

added to the time each time a new computation is performed. This fixed step can 

be fixed (between 0 and 99:59:59) by clicking on the hour, minute or second of 

the ∆T displayed, and changing with the little arrows in the right.

3.2.5.2 PLANETARIUM

When the animation is launched, a new dialog is displayed (fig. below), 

indicating the current time and allowing to pause or to stop the animation. A 

small disk shows the progress of the computation.



If the “Stop” button is selected, or the dialog is closed with the close box, 

the animation stops. If the “Pause” button is selected, the animation stops 

until the “Resume” button is selected. 

3.2.6 “Quit” ITEM

When the “Quit” item is selected, if the current ephemeris have not been saved, 

a dialog asks if the user wants to save it.

3.3 “Edit” MENU

The “Edit” menu consists of the usual items (Undo/Cut/Copy/Paste/Clear).

When MacAstro is in the foreground (and not a desk accessory), all these items 

are disabled except for the item “Copy” which is changed in “Copy sky.” When 

selected, a picture of the sky currently displayed is copied to the Clipboard. 

It is then possible to paste this picture to the scrapbook or any Paint/Draw 

programs. 

The last item of the menu, “Zoom out” is enabled only when a part of the sky is 

currently enlarged, and allows to zoom out.

3.4 “Window” MENU

The “Window” menu consists of 5 items : one to display a little window which 

indicates the coordinates of the arrow of the mouse, one to display the current 

phase of the Moon, two to display the current positions of the satellites of 

Jupiter and Saturn, and one to display the sidereal time.

3.4.1 “Coordinates” ITEM

The “Coordinates” item, when selected, displays a little window (fig. below). It 

shows, when the cursor of the mouse is within the disk of the sky, the 

corresponding coordinates, in the horizontal system (azimuth and altitude), and 

if desired in the equatorial system (right-ascension and declination).



Each click in the zoom-box of the window switches between the mode where only 

the geocentric coordinates are displayed, and the mode where both geocentric and 

celestial coordinates are displayed.

3.4.2 “Moon phase” ITEM

The “Moon phase” item, when selected, displays a window (fig. below) with a 

drawing of the current phase of the Moon. The age of the Moon (number of days 

since last new Moon) is also displayed, with the abbreviation “NM”, “FQ”, “FM”, 

and “LQ” sanding for New Moon, First Quarter, Full Moon, and Last Quarter. 

It is possible to enlarge or to reduce the size of the drawing by clicking in 

the bottom right corner of the window and dragging.

3.4.3 “Jupiter satellites” / “Saturn satellites” ITEMS

The “Jupiter satellites” and “Saturn satellites” items, when selected, display a 

representation of the 4 major satellites of Jupiter (Io, Europa, Ganymede, 

Callisto) and Saturn (Tethys, Dione, Rhea, Titan). Their elongations (distance 

from the planet with its diameter as unity) are also displayed (see fig. below).



When a radio-button corresponding to a satellite is selected, a little arrow is 

displayed to show the position of the satellite on the drawing. Likewise, 

clicking by a point figuring a satellite on the drawing will select the radio-

button corresponding to the satellite selected.

3.4.4 “Sidereal time” ITEM

The “Sidereal time” item, when selected, displays a representation of the 

current sidereal time, both with an analogic and a numeric clock (fig. below).

3.5 “Objects” AND “Stars” MENU

The “Objects” and “Stars” menus allow to display the ephemeris of any of the 

objects available (Sun, Moon, the 8 major planets and the objects from the 

catalog).

The ephemeris are displayed in a window (fig. below) which contains :

• A ruler showing the progress of the calculation,

• The name of the object,

• Its constellation (if it is an object from the catalog), or its diameter,

• Its magnitude,



• Its right-ascension, declination, azimuth and altitude for the observation 

time,

• The setting, upper culmination (transit), and rising time for the date 

selected. A time corresponding to the eve is preceded by a “-”, a time 

corresponding to the next day is preceded by a “+”, and if the object never 

rises nor sets, “-- -- --” is displayed instead of the time.

Meanwhile, a little arrow is shown next to the point figuring the object in the 

sky, if the object in visible (above the horizon).

3.5.1 “Objects” MENU

In the “Objects” menu are regrouped all the items to enter coordinates for which 

the ephemeris will be computed, to launch immediately the computation, and to 

display the ephemeris for the 10 main objects of the Solar System.

3.5.1.1 “Enter position…” ITEM

The first item of the planet menu, “Enter position…”, allows to enter the 

coordinates of a particular point for which the ephemeris will be displayed. A 

dialog is displayed (fig. below), where the coordinates can be entered either 

with the keyboard, or with arrow of the mouse by clicking into the sky window.



3.5.1.2 “Calculate now” ITEM

When selected, the “Calculate now” item launches immediately the computation of 

the position of the objects in the sky. If the option “Calculate when Ordered” 

of the “Preferences” dialog (see 3.2.3) has not been checked, the computation is 

launched automatically after 2 seconds of inactivity. If the option has been 

checked, the computations are launched only when this item is selected.

3.5.1.3 NEXT ITEMS

The 10 next items allow to select an object from the solar system for which the 

ephemeris is displayed.

3.5.2 “Stars” MENU

When a star catalog is open (enough memory), each item of the “Stars” menu is a 

constellation, and each item of the sub-menu is a star from the constellation. 

To select a star for which the ephemeris will be displayed, simply select the 

item corresponding to the constellation, and then select the name of the star in 

the sub-menu displayed.

4. “Star Compiler 1.0”

“Star Compiler 1.0” is a companion program for MacAstro which allows to compile 

any text-file catalog of stellar objects into a format readable by MacAstro. 

4.1 USE OF “Star Compiler”

When launched, it displays a dialog to select the text-file catalog. It is 

possible to choose to display in the standard “Get File” dialog only the TEXT 

file which name ends with “.CAT” (to easier its localization), or any text file. 

Then a dialog is displayed (fig. below) to show the progress of the reading. At 

any time it is possible to stop the compilation and to exit by clicking the 

“Cancel” button.



If an error in the format of the catalog is detected, a dialog “Error in…” is 
displayed, and the program exits. If no error is detected, a new dialog allows 
to select the copy of MacAstro where to load the compiled version of the new 
catalog. If no errors are detected, the program exits, otherwise a dialog “Can't 
save in…” is displayed.

4.2 FORMAT OF THE STAR CATALOG

A star-catalog consists of a text file, where each line corresponds to one 
object. The maximum number of objects is 1000, spread among 88 constellations 
(number of constellations in the sky).

These objects should OBLIGATORY be grouped by constellation, and the 
constellations should be sorted alphabetically to easier their localization in 
the “Stars” menu of MacAstro. It is recommended to store the objects in a same 
constellation by decreasing order of magnitude.

To each object are associated 5 rubrics, each rubric separated by a TAB (code 
9), and each object separated by a RETURN (code 13). These rubrics are :
• The name of the object (not more than 20 characters),
• The name of the constellation (not more than 20 characters),
• The visual magnitude of the object, preceded by a - if negative,
• The declination of the object in decimal degrees,
• The right-ascension of the object in decimal degrees, between 0 and 360°.

5. REGISTRATION FORM

• Name:
  ________________________________________________________

• Mailing Address:
  ________________________________________________________
  ________________________________________________________
  ________________________________________________________
  Country  _______________________________________________
  E-mail (if any)  _______________________________________

• Where did you get your first copy of MacAstro ?
  ________________________________________________________

• Mail To:

  Nicolas Mercouroff
  P.O.Box # 390929
  Cambridge, MA 02139
  USA

• Thank you for supporting shareware software (and thanks for the $20).


